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Important Information 
 
USE OF INTERPSS SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A LICENSE 
AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH 
SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR 
INSTALLATION OF THE SOFTWARE, OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER 
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS 
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN 
AGREEMENT TO BE BOUND BY THE SAME. 
 
This document contains confidential information that is subject to U.S. and international copyright laws and treaties. No part of this document 
may be reproduced in any form without the written authorization of InterPSS Systems LLC. 
 
InterPSS, OpenCIM, and the InterPSS logo are either registered trademarks or trademarks of InterPSS Systems LLC in the United States and/or 
other countries. 
 
JAVA and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other 
countries. 
 
Eclipse and all Eclipse-based trademarks and logos are trademarks or registered trademarks of the Eclipse Foundation in the United States and 
other countries. 
 
All other product and company names and marks mentioned in this document are the property of their respective owners and are mentioned for 
identification purposes only. 
 
THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT ALL OPERATING SYSTEM 
PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED AT THE SAME TIME. PLEASE SEE THE README.TXT FILE 
FOR THE AVAILABILITY OF THIS SOFTWARE VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM. THIS DOCUMENT IS 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. 
 
THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE 
PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF 
THIS DOCUMENT. INTERPSS SYSTEMS LLC MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR 
THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME. 
 
THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR INDIRECTLY, BY OTHER 
DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND 
"READ ME" FILES. 
 
Copyright © 2008 - 2010  InterPSS Systems LLC. ALL RIGHTS RESERVED. 

InterPSS Systems LLC Confidential Information
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1 OVERVIEW 

1.1 INTRODUCTION 
 

The Common Information Model (CIM) is an effort to develop a common power system information model 
that can be shared and exchanged among different applications across operations and planning in utility 
companies and, in the future, power trading companies to facilitate seamless power system information 
sharing and integration. Being a common power system information model, CIM was designed to serve as 
the foundation for integrating modern information systems in the power industry. Real-time integration of 
power system application is not feasible without a common information model that can be understood by 
everyone (human beings as well as computers).  

We have observed that when major ISOs (Independent Service Operators) are creating, expanding and 
maintaining their CIM model (mostly based on RDF), their model, which is used by many regional utility 
companies, is growing bigger and bigger. For example, the latest ERCOT model is 4.4 GB as of October, 
2008. InterPSS OpenCIM is developed with the following challenges in mind: 

• No enterprise relational database software such as Oracle is needed.  

• No high-end hardware and complicated configuration is needed. 

• Easy to be adapted or extended to accommodate enhancement and customer-specific requirements. 

• Easy to be integrated with other power system applications. 

1.2 FEATURES 
 

InterPSS OpenCIM solves the above concerns by providing: 

• A graphical tool that can show all details of a CIM model, or selectively show only the interested/relevant 
part of the model.  

• A Java-based tool with both GUI and API that can be run on any platform that has Java runtime software 
installed. 

• An innovative RDF parser that parses large RDF model files quickly and efficiently. 

• A flexible architecture design that can adapt quickly to different CIM versions and/or extensions by 
different ISOs. 

• An OpenCIM API that can be used in any other power system applications in which programmatically 
managing CIM models is a requirement.  

• No need for expensive enterprise relational database software such as Oracle; simple and easy installation. 

• No need for high-end hardware. Parsing and displaying the large 4.4 GB CIM model can be done on a 
professional laptop computer. 

• Intrinsic capability to convert CIM to the proposed IEEE ODM model and perform power system 
simulations. 

• Intrinsic capability to seamlessly integrate with other power system information systems. 
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1.3 BASIC CONCEPTS 
 

InterPSS OpenCIM has a CIM object model, which accurately represents the CIM standard as published by 
IEC. The OpenCIM CIM model has also been extended to represent the extensions by ERCOT. OpenCIM 
maintains a CIM model vocabulary dictionary. New vocabulary could be added to accommodate future 
changes of the CIM standard and cover extensions by other ISO.  

When processing a CIM RDF file using InterPSS OpenCIM, there are two main steps, as follows: 

• The CIM information stored in a RDF file is first mapped to the OpenCIM object model. For large RDF 
files, the object model is saved into the local file system. 

• Then the object model is used for viewing RDF records and the relationships. For large RDF files, the 
saved model is loaded into InterPSS OpenCIM for the viewing purpose in a very efficient manner. 

 

1.3.1 Model Object and Data Object 

 Analysis of the current ERCOT CIM model file indicates that 2/3 of the CIM objects in the file are related 
to data, such as RegularTimePoint or AnalogValue. The user often is not interested in the actual value of 
these data objects. Therefore OpenCIM breaks a large CIM model into two sets: Model Object and Data 
Object. When the Processing Large RDF file user preference option is selected, user has the option to load 
the model objects and data objects into OpenCIM Viewer separately. 

. 
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2 INSTALLATION 

2.1 SYSTEM REQUIREMENT 
Minimum: 1.8 GHz CPU, 2 GB physical memory. 

 

2.2 SOFTWARE REQUIREMENTS 
Java Runtime Environment (JRE) 1.6.x is required. It can be downloaded for free at Sun Microsystem’s 
website at http://java.sun.com/javase/downloads/index.jsp. Choose the latest update of “Java SE Runtime 
Environment (JRE) 6”. 

Install the downloaded JRE 1.6.x. Add the path to the bin directory of the installed JRE to the system 
variable PATH. For example: 
 "C:\Program Files\Java\jre1.6.0_xx\bin" 

 

 

Please note: this step is normally done automatically by the Java installers. 
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2.3 INSTALLATION PROCEDURE 

2.3.1 Download the installation zip file, interpss-opencim-install-<version_no>-<build_no>.zip, into a 
temporary folder. You should see the following three files: 

 

2.3.2 The install_readme.txt file briefly describes the installation procedures. 

2.3.3 Open the install.cmd file, and modify the line for JAVA_HOME to reflect the Java JRE installation folder 
described in 2.2, e.g.: 

set JAVA_HOME=C:/Program Files/Java/jre1.6.0_07 

2.3.4 Save, and then run install.cmd. Follow the instructions on the screen and finish the entire installation 
process. 

2.3.5 OpenCIM is distributed with a community license key file, which can process up to 10,000 RDF records. If 
you have obtained a license file from InterPSS, copy the license file provided by InterPSS Systems LLC into 
the <opencim_home>/license folder and rename it to opencim.license. 

Please note: InterPSS OpenCIM cannot function properly without a valid license file. 

2.3.6 CIM version: the CIM standard over the years has been evolving and resulted in different CIM versions (10, 
11, 13, 14, etc.).  OpenCIM currently supports CIM version 10, CIM version 14 and the ERCOT CIM 
version, which is an extension to CIM version 11. The version field in the IEC61970 CIMVersion.version 
record normally has a format of <CIM version><minor version>. For example, in CIM version 14, the field 
might have a value of CIM14v002. The CIM version validation inside OpenCIM checks the CIM version 
prefix. Therefore CIM14v001, CIM14002 and CIM14_v003 are all valid for CIM version 14. 

 In InterPSS OpenCIM, you can set the CIM version that you are working on in the <opencim_home>/ 
properties/ opencim.properties file. Uncomment the right section for the CIM version you use, and 
comment all the other sections. 

 # uncomment the following to use Cim10 model 

 #OpenCIM.Model=Cim10 

 #OpenCIM.Dictionary.Rdf_dict=cim10_rdf_dictionary.xml 

 #CustomView.Name=Cim10 View 

 #CustomView.XmlFileName=cim10_view.xml 

 Save the opencim.properties file, and restart InterPSS OpenCIM. 

Please note: you need to restart OpenCIM after the above change to make the change effective. 
 
InterPSS OpenCIM is currently configured to work with CIM Model version: Cim14. If you need to work on 
a different CIM version, modify <install_dir>/properties/ opencim.properties. Some operations may fail if 
the two CIM model versions don't match. See the User's Guide for details. 
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2.3.7 Memory configuration: InterPSS OpenCIM is shipped with a typical memory configuration. If you need to 
change it, e.g., to increase the system memory allocation for InterPSS OpenCIM, you can modify the 
opencim.ini file as follows. 

 -vmargs   

 -Xms512m: the minimum (or startup) memory allocation in MB. 

 -Xmx1024m: the maximum memory allocation in MB. 

Increase the –Xmx parameter to the maximum (by trial and error) without seeing the following startup error. 

 

 
 

Save the opencim.ini file and restart InterPSS OpenCIM. 

 

2.4 START INTERPSS OPENCIM SOFTWARE 
Start InterPSS OpenCIM by going to Start > All Programs > InterPSS > InterPSS OpenCIM, or double-click on the 
InterPSS OpenCIM desktop shortcut, or execute <opencim_home>/opencim.exe. 
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3 INTERPSS OPENCIM QUICK START – A TUTORIAL 

 In this quick start tutorial, we will load a sample RDF file (located in <opencim_install_dir>/samples 
directory) into InterPSS OpenCIM; build an OpenCIM model from the RDF file and view the RDF record 
details. In addition, we will perform the RDF Analysis and Find RDF Record functions on an RDF file. 

 The tutorial will also cover the configuration details of InterPSS OpenCIM. 

 After this tutorial, you will be fairly familiar with all the major functions of InterPSS OpenCIM. 

  

3.1 START INTERPSS OPENCIM 
Start InterPSS OpenCIM.  

 
 

See Section 4. InterPSS OpenCIM User Interface for detailed descriptions of the different panel 
areas in the above screen. 
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You may see the following pop-up dialog on the limitations of InterPSS OpenCIM Community Edition. 

 

 
 

Contact info@interpss.com if you see any startup error related to license issues. 
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3.2 CREATE AN INTERPSS OPENCIM PROJECT 

3.2.1 Go to menu item File > New Project…. 

 

3.2.2 In the New dialog, select wizard InterPSS > OpenCIM Project. Click on Next. 
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3.2.3 In the New OpenCIM Project dialog, enter Tutorial for Project name. Click on Next. 

 
Note: At this stage, you can create an empty OpenCIM project by clicking the Finish button – you can add 
one or multiple RDF files to the project later on by following the steps in Appendix A.1 Adding RDF 
files to an OpenCIM project. 

 

3.3 IMPORT RDF FILE 

3.3.1 In the Import Rdf File dialog, click on Browse… and select the RDF file that needs to be imported. Click 
on Finish. 

 
 

Note: Currently InterPSS OpenCIM only support RDF files with an extension or .xml or .rdf.  If your RDF 
file has a different file extension, please rename the file extension to either .xml or .rdf. 
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3.3.2 The RDF file import loading time depends on the size of the RDF file. After it is imported, the new 
Tutorial project is created. 
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3.4  BUILD OPENCIM MODEL 
There are three ways to build the OpenCIM model from the RDF file imported: 

- Highlight the RDF file. Go to menu item Run > Build OpenCIM Model. 

 
 

- Right-click on the RDF file and select Build OpenCIM Model from the popup menu.  

 
- Click on the RDF file and then click on Build OpenCIM Model from the Toolbar.  
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If the CIM version number is either absent in the RDF file or different from what is configured for InterPSS 
OpenCIM (see Section 2.3.6),  a warning message will pop up as follows. 

 

 
 

This is just a friendly remind that you might set OpenCIM CIM version configuration wrong, and your RDF 
file might be interpreted by OpenCIM using a wrong CIM version.  

 

Please note: OpenCIM is using the <cim:IEC61970CIMVersion.version> element to determine the CIM 
version of the RDF file under processing. For example: 

 <cim:IEC61970CIMVersion.version>CIM14v001</cim:IEC61970CIMVersion.version> 

  

3.5 VIEW DETAILS OF OPENCIM MODEL 
 

Load OpenCIM Model (Large RDF Files Only) 

For large RDF files, the object model build in the Build OpenCIM Model step is saved to a set of files. To 
view the model, you need to Load OpenCIM Model first. There are three ways to load the built OpenCIM 
model file details: 

- Highlight the built model file. Go to menu item Run > Load OpenCIM Model. 
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- Right-click on the built model file and select Load OpenCIM Model from the popup menu. 

 
 

- Select the built model file and click on Load OpenCIM Model from the Toolbar. 
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In all cases, the tree structure of the built OpenCIM model will appear in the Model View (lower left) panel, 
which has a title of Model View. 
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3.6 VIEW DETAILS OF OPENCIM MODEL 
Expand the tree structure in the lower left panel, which has a title of Model View. When a model node 
(which is not a folder) is selected, the details of that node can be show in the upper-right panel in one of the 
following three ways: 

- Highlight the model node. Go to menu item View > View Rdf Record. 

 
- Right-click on the model node and select View Rdf Record from the popup menu. 
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- Double-click on the model node. 

In all cases, the details of the selected model node will appear in the upper-right panel Model View. 

If there is a reference in the RDF record details, a link appears at the end of a section. Clicking on the link 
will bring up the RDF Record Detail Panel for the referenced model. For example, 
theSubGeographicalRegion has a Region link to its parent GeoGraphicalRegion object, as shown in the 
screenshot above. 

3.7 LOAD FLOW ANALYSIS 
You can select the root node of the model tree view in the lower-left panel and run load flow analysis. The 
result will be displayed in the upper-right panel (the same area as the RDF record view). You can trigger the 
load flow analysis in one of the following three ways: 

- Highlight the root of the model tree view. Go to menu item View > Loadflow Analysis. 

 
 

- Right-click on the root of the model tree view and select Loadflow Analysis from the popup menu. 
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 If you select any node in the model tree view other than the root, you will get this alert. 

 
- Select the on the root of the model tree view and click on Loadflow Analysis from the Toolbar. 

 
In all cases, the details of the load flow analysis will appear in the upper-right panel. 

 
 

Please note: CIM based power system simulation currently only available for CIM version 14. 
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3.8 TRANSFORM CIM TO ODM 
The ODM is an Open Model for Exchanging Power System Simulation Data, ODM - Open Data Model for 
short. The model will be defined using an XML schema. The schema is currently maintained by the IEEE 
PES OSS Task Force. More details can be found at : 
http://sites.google.com/a/interpss.org/interpss/Home/ieee-pes-oss  

You can select the root node of the model tree view in the lower-left panel and convert the current CIM 
model to ODM model document. The result will be displayed in the upper-right panel (the same area as the 
RDF record view). You can trigger the Convert to ODM in one of the following three ways: 

- Highlight the root of the model tree view. Go to menu item View > Transform CIM model to ODM 
document. 

 
 

- Right-click on the root of the model tree view and select Transform CIM model to ODM document 
from the popup menu. 
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 If you select any node in the model tree view other than the root, you will get this alert. 

 
- Select the on the root of the model tree view and click on Loadflow Transform CIM model to ODM 

document from the Toolbar. 
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In all cases, the details of the load flow analysis will appear in the upper-right panel. You can select the 
Design view or the Source view on the generated ODM document. 
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4 INTERPSS OPENCIM USER INTERFACE 

The major components of InterPSS OpenCIM user interface are: 

• Menu. 

• Toolbar. 

• Workspace: 

o Project Explorer 

o Model View Panel 

o RDF Record Detail Panel 

o Message Console. 
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4.1 MENU ITEM DESCRIPTIONS 

4.1.1 File: 

 
• New project …: create a new OpenCIM project. 

• Close All Viewers: in the RDF Record Details Panel, multiple pages can be opened, each with a 
tab, when Multiple viewer is selected for Rdf Record Viewer Option. Multiple viewer or Single 
viewer is configured using User Preference … menu item in this group. 

• User Preference…: user preference settings for InterPSS OpenCIM user interface: 

o Rdf Record Viewer Option: Multiple viewers or Single Viewer in the RDF Record 
Details Panel. To close all open RDF details panels, use Close All Viewers. 

o Rdf Viewer Config: in the RDF Record Details panel: 

 Show field help message: show/hide model field help message. 

 Show field profile info: show/hide model field profile information. 

 
• Exit: exit InterPSS OpenCIM. 
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4.1.2 Edit: 

 
 

• Copy: Copy function. Short-cut key Ctrl+C. 

• Paste: Paste function. Short-cut key Ctrl+V. 

• Delete: Delete function. Short-cut key Delete. Also available on the Toolbar. 

 These actions may not be available in some context cases. 

4.1.3 Run: 

 
 

• Build OpenCIM Model: build OpenCIM model from an RDF file. Only activated when an RDF 
file is selected in Project Explorer. 

• Load OpenCIM Model (Model + Data): load OpenCIM model and data. Only activated when an 
OpenCIM model file under <project>/model is selected in Project Explorer. 

• Load OpenCIM Model objects: load OpenCIM model objects only. Only activated when the 
Processing large RDF file checkbox is checked and an OpenCIM model file under 
<project>/model is selected in Project Explorer. 

• Add OpenCIM Model Data Objects: add OpenCIM data objects to the already loaded OpenCIM 
model objects. Only activated when the Processing large RDF file checkbox is checked, an 
OpenCIM model file under <project>/model is selected in Project Explorer and Load OpenCIM 
Model objects has been run. 

• Rdf Analysis: Run OpenCIM analysis on the selected RDF file. Only activated when an RDF file is 
selected in Project Explorer. 

• Find Rdf Record…: Find one or multiple RDF records in the selected RDF file by either RDF IDs 
or RDF names. Only activated when an RDF file is selected in Project Explorer. 
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4.1.4 View 

 
 

• View Rdf Record: Show the details of the selected model node in the Model View panel. The details will 
be shown in a new RDF Record Details panel (if the user preference is Multiple Viewers) or in the 
existing RDF Record Details panel (if the user preference is Single Viewer) Only activated when a 
model node is selected in the Model View panel. 

• Loadflow Analysis: run load flow analysis on the current CIM model. The result will be displayed in the 
upper-right panel (the same area as the RDF record view). 

• Transform CIM model to ODM document: transform the current CIM model to ODM model document. 
The result will be displayed in the upper-right panel (the same area as the RDF record view). 

4.1.5 Window 

 
 

• Reset Perspective…: restore the default original OpenCIM configurations. 
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4.1.6 Help 

 
 

• Help Contents: User’s Guide. Same content as this document. 

• About InterPSS OpenCIM: InterPSS OpenCIM product information. 
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4.2 TOOLBAR ITEM DESCRIPTIONS 

4.2.1 Build OpenCIM Model: 

 
 

4.2.2 Load OpenCIM Model from the selected xml file: 

 

4.2.3 Load OpenCIM Model, model objects only, from the selected xml file: 

 

4.2.4 Add OpenCIM model data objects to selected OpenCIM model objects: 

 

4.2.5 View RDF Record: 
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4.2.6 Run Loadflow analysis of the current model: 

 

4.2.7 Run ODM transformation on the current model: 

 
 

4.2.8 Delete: delete the highlighted item. May not be available in some context cases. 
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4.3 WORKSPACE 

4.3.1 Project Explorer: 

This is the OpenCIM project organizer. Multiple projects can be contained in this explorer. Within each 
project, resources such as RDF files, OpenCIM model files and OpenCIM data files are organized in 
different folders 

4.3.2 Model View Panel: 

This is the tree view of the OpenCIM model built from an RDF file. If a node is a model element, the 
associated icon (if any) will be shown. RDF record details can be show in the RDF Record Details panel, 
when the View Rdf Record action is triggered. See 4.4 View Details of OpenCIM Model for details on 
how to trigger the View Rdf Record action. 

4.3.3 RDF Record Details Panel: 

When the View Rdf Record action is triggered, the detail of the selected model node is shown here. User 
Preference Rdf Record Viewer Option controls whether a single panel or multiple panels will be used. 
See 4.1.1 File menu items on how to configure Rdf Record Viewer Option. 

4.3.4 Message Console: 

This is the console where significant error and info messages, RDF Analysis and Find RDF Record… 
results, etc, are shown. The same messages will also output to <opencim_home>/log/opencim_log.0. 
These messages are very important for trouble-shooting. 
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5 USING INTERPSS OPENCIM 

5.1 HANDLING LARGE RDF FILES 
Processing (including building model and loading model) large (multi-GB) RDF files can be very time 
consuming. OpenCIM uses different approaches when it comes to processing large and small RDF files. 

- Small file: Run > Build OpenCIM Model will build and load the RDF model in one step, i.e., after the 
Build OpenCIM Model operation, the whole RDF model tree structure is available in the lower-left 
Model View panel for viewing. This is extremely fast since every piece of information only stays in 
memory. If you shut down InterPSS OpenCIM, nothing is saved, and you have to rebuild the model the 
next time you start InterPSS OpenCIM. 

- Large file: Running Run > Build OpenCIM Model in this case will only build the OpenCIM model and 
save the model information and data information in separate model files and data files. Refer to Section 
1.3.1 for definitions of model and data information. The next step you can either  

o Run > Load OpenCIM Model (Model + Data) or  

o Run > Load OpenCIM Model Objects 

 Either way you can start to navigate the model tree view in the lower-left Model View panel. With the 
second way, you can optionally go Run > Add OpenCIM Model Data Objects to load all the data 
object details if you are interested in the leaf details within the model tree. 

When processing large RDF files, all the processing results are saved in files, so you don’t have to 
rebuild and load the model again when InterPSS OpenCIM is restarted. 

Users of InterPSS OpenCIM have control over what file sizes are “large” and what are “small” – open 
<opencim_home>/properties/opencim.properties and locate the following line: 

     Model.LargeRdfFile.SizeMB = 1024 

Change the value to a number in MB as what you define as the dividing line between “large” and “small” 
RDF files. Save and close opencim.properties and restart InterPSS OpenCIM.  

5.2 SAVING YOUR WORK 
There is no need to explicitly save you work. All your work is saved under <opencim_home>/workspace/ 
<your_project>. 

5.3 ORGANIZING YOUR WORK 
You should organize your models using OpenCIM project. OpenCIM projects can be individually opened, 
saved, closed, exported and imported. 

5.4 SHARING YOUR WORK WITH OTHERS 
To share an InterPSS OpenCIM model project, zip up all content under <opencim_home>/workspace/ 
<your_project> and share the zip file. 
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APPENDIX A.1   ADDING RDF FILES TO AN EXISTING OPENCIM PROJECT 

Additional RDF files can be added later to an existing InterPSS OpenCIM project. 

Right-click the rdf folder, and select New > File from the popup menu. 

 

There are two ways that new RDF files can be included: 

• Create a new file: enter File name. Click Finish. And paste the content of the RDF file into this 
newly created file. 
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• Include an existing file: Click on the Advance >> button. Check Link to file in the file system. 
Click on Browse… and select the RDF file to include from the local file system. Click on Finish. 

 
Note: The text content of the RDF file may be opened in the RDF Record Details panel. Just close it if 
you do not need it. 

 

Note: You can also delete an RDF file from the project by choose the RDF file in the Project Explorer, 
and click on menu Edit > Delete or Toolbar Delete. 

 

Note: It would be much quick to add files if you copy the new files, go to the target folder under 
<eclipse_workspace> and paste the new files there within Windows explorer. Come back in Eclipse 
and refresh the workspace (by hitting F5)  
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APPENDIX A.2   RDF ANALYSIS 

Before building the OpenCIM model, an RDF file can be analyzed for missing classes and attributes. 
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There are two ways to run RDF analysis on an RDF file: 

- Highlight the RDF file. Go to menu item Run > Rdf Analysis. 

 
 

- Right-click on the RDF file and select Rdf Analysis from the popup menu. 
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Either way, the analysis report will show up in the lower-right Console panel: 
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APPENDIX A.3   FINDING RDF RECORD 

RDF records can be found by their RDF IDs or by their RDF names. There are two ways to find RDF records in an 
RDF file based on RDF IDs or RDF names: 

- Highlight the RDF file. Go to menu item Run > Find Rdf Record 

 
 

- Right-click on the RDF file and select from the Find Rdf Record popup menu. 
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- The Find Rdf Record dialog appears. 

 

- Select the appropriate option of either Rdf Id or Rdf Class Name. Enter the Rdf Id or Rdf Class 
Name, and click on OK. The search result appears in the lower-right Console panel. 

 
 

 Note: multiple Rdf Ids or Rdf names can be entered, separated by “|” (the vertical bar). 


